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 Introduction 
REGIONS Gamma-Gamma system is intended to model space-energy distribution of gamma-quanta 

in physical continuums. The program is based on Monte-Carlo simulation algorithm. 
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 User Interface 
 The REGIONS Gamma-Gamma program user interface consists of four main windows (picture 1). 

 

 
 

Picture 1. REGIONS Gamma-Gamma program user interface. 

 

The Main Menu window contains menu strip to execute all program operations. 

The Main Screen window displays current graphical information and allows user to manipulate 

objects (select, unselect, get object information and so on) by mouse.  Screen view management 

includes the following operations: 

Zoom In, Zoom Out: Mouse Wheel Down, Up 

Pan: Mouse Left Down -> Mouse Move 

Rotate (about global coordinate system center): Mouse Right Down -> Mouse Move 

Zoom by window: Ctrl+Mouse Left Down -> Mouse Move -> Mouse Left Up 

(to escape Zoom by window while Mouse Moving just press Escape). 

If the Main Screen window is not visible – use main menu command System -> Graphics -> Main 

Screen Window to show the screen. Main Screen window has Popup menu that can be opened by 

pressing Mouse Right button on the window. 

The Main Object Inspector window allows user to change properties of objects. To set new property 

value just input (or select from list) new value and press Enter. Some complex properties (such 

as Colors, Vectors and so on) have their own Property Editors those can be executed by pressing 

button on the right of the property. Some properties are Read Only (such as ID of the object, 

Area of the surface and so on) and cannot be edited (but they are displayed by Object Inspector). 

The Main Object Inspector window is commonly shown when user executes Edit operations from the 

main menu. 

The Log window (is not shown on the picture) displays text information about user action results, 

solution progress and results, errors and hints. To make the Log window visible use main menu 

command System -> Log -> Show Information Log Window. 
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 Problem Solution Procedure 
Problem Solution procedure includes several stages which should be (commonly) implemented 

in the order as described below. 

 Creating new problem 

 First of all you need to create new problem. Use main menu command Problem -> New Problem. 

In the displayed form input the Name of the problem, select working directory (press button to 

use Directory Browser), select Problem Analysis from the list and press Apply button. New problem 

will be created and Geometry Model will be loaded. If problem file with the same name exists in 

the same directory – problem data information will be loaded from the file. 

  

 Problem structure 

A REGIONS Gamma-Gamma Problem is a set of Models. A Model is again a set of objects of 

some Base type. For an example, Geometry model is a set of geometry objects – points, lines, 

surfaces and solids. Objects in model can be connected with other objects in the same model and 

in the other models. REGIONS Gamma-Gamma Problem consists of the following models: 

 Geometry model. 

 Material model. 

 Boundary model. 

 Measuring model. 

 Result model. 

With each model user can make the following operations (menu strip Problem): 

Load model – model data is loaded into program memory and is ready to manipulate with the model 

objects (if the model file exists on the disk in the problem directory – model data is loaded from 

the file). 

Load model from – model data is loaded from the selected by user file and is ready to manipulate 

with the model objects. 

Unload model – model data is saved into model file in the problem directory and destroyed in the 

problem memory (so it is not accessible to manipulate with). 

Save model as – model data is saved into selected by user (so it is still accessible to 

manipulate with). 

Save model – model data is saved into the model file in the problem directory (so it is still 

accessible to manipulate with). 

 All problem data can be saved into files with the main menu command File -> Save Problem. 

With the main menu command File -> Save Problem as… all problem data saved into files with 

selected name in selected directory. If some model data is not loaded into the program memory and 

the model file exists – the file is just copied with the new name. Saving problem with the new 

name causes the name of the problem and the working directory changing. 
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 Creating Geometry model 

 Geometry model describes the geometry of the Boundary Value problem. Geometry model 

consists of a set of geometry objects – points, lines, surfaces and solids. 

The REGIONS Gamma-Gamma program uses Boundary Representation (BREP) technique, so to 

create a solid body a user must create all surfaces the body consists of. A surface can be 

created by existing lines or as new surface with its own parameters (for an example – parametric 

surface). A line can be created by using existing points or as new line with its own parameters 

(for an example – parametric curve). A point can be created by its coordinates or can be created 

on existing object (for an example – on a line). 

 All created geometry objects can be changed in any moment of geometry modeling. Use main 

menu command Geometry -> Edit ->… to change geometry object properties. Because (in common) 

geometry objects are connected with each other (for an example a straight line created by end 

points), changing one geometry object leads to changing the other, connected with it. 

 Each geometry object has its own Local Coordinate System (LCS). The parameters of Local 

Coordinate systems (translation, rotation and so on) are described relatively to the Global 

Coordinate system. Local Coordinate systems can be changed via translation, rotation and other 

operations. So the geometry objects can be changed via LCS manipulations too. 

 All geometry objects are created in the current Working Space. Working Space is simply an 

object representing a Local Coordinate System. To show Working Space use main menu command 

Problem -> Options (page Graphics). To manipulate Working Space use main menu command Problem -> 

Edit Working Space. Using Working Space for geometry object creation means just using the initial 

Local Coordinate System parameters for the object. 

 

Creating Points 

 Use main menu command Geometry Model -> Create -> Point to create a point by coordinates. 

Point window will be shown (picture 2). 

 
Picture 2. Point window. 

 

Input coordinates of the point in Local Coordinate System (the type of the system can be selected 

from the list). While inputting coordinates – the preview of the point is shown on the Main 

Screen. Press Create or Create+ button to create the point. 

 

Creating Lines 

Use main menu command Geometry Model -> Create -> Straight Line to create a line by two 

end points. Straight Line window will be shown (picture 3). 
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Picture 3. Straight Line window. 

 

Two points must be chosen to create Straight Line (so at least two points must be created 

before). Use Object Choice interface (picture 4) to choose points. 

 

 
Picture 4. Object Choice interface. 

 

Object Choice interface allows two ways to get object. Use >> button to choose object with Object 

Browser (picture 5). 

 
Picture 5. Object Browser window. 

 

When an object selected in the Object Browser it is highlighted on the Main Screen. Press Apply 

button to choose the selected object. 

Use … button to activate Object Picking by mouse. Object Picking will be activated and object can 

be chosen by mouse on the Main Screen. When Object Picking is activated the current object is 

highlighted on the Main screen while mouse moving. 

When both end points are chosen – the preview of the line is shown on the Main Screen. Press 

Create or Create+ button to create the line. 

Use main menu command Geometry Model -> Create -> Parametric Curve to create a freeform 

line by equations. Parametric Curve window will be shown (picture 6). 
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Picture 6. Parametric Curve window. 

 

Parametric Curve is a freeform line that determined by three equations 
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were 
1x , 

2x , 3x  - coordinates of the line point (in Local Coordinate System),  lF1 ,  lF2 , 

 lF3  - functions of Line Parameter l . The Line Parameter l  changes from 0 to 1.0. 

So, three functions of the variable l  must be given to create a Parametric Curve. User can input 
the function equations himself or can use Curve Library menu to select existing line equations. 

Curve Library menu contains also operations to add line equations into library, save equations in 

text files and read equations from text files. There are two libraries – Standard Library 

contains simple line equations (such as arc, elliptic arc and so on), Additional library contains 

more complicated line equations.  

When all three equations set – the line preview is shown on the main screen. If there are errors 

in equations – hints are shown in the Log window. Press Create or Create+ button to create the 

line. 

 

Creating Surfaces 

Use main menu command Geometry Model -> Create -> Two Line Surface to create a surface 

that starts with the first line and ends with the second one (so called ruled surface). Two Line 

Surface window will be shown (picture 7). 

Two end lines must be chosen to create a ruled surface. Use >> buttons to choose lines with 

Object Browser or … buttons to activate Object Picking by mouse on the Main Screen. 

When two lines are chosen – the preview of the surface is shown on the Main Screen. Press Create 

or Create+ button to create the surface. 
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Picture 7. Two Line Surface window. 

 

 NOTE about surfaces: any surface has outer face and inner face (the former displayed on 

the screen with surface color and the last is darkened). The outer direction is where the normal 

to the surface points to, and the inner is inverse direction. When a preview of a surface is 

shown – the normal direction is displayed as an arrow. The surface direction can be changed to 

the inverse one by changing the property Inverse Direction value to the True (use command 

Geometry Model -> Edit -> Edit Surfaces to edit surface properties). 

Use main menu command Geometry Model -> Create -> Parametric Surface to create a freeform 

surface by equations. Parametric Surface window will be shown (picture 8). 

 
Picture 8. Parametric Surface window. 
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Parametric Surface is a freeform surface that determined by three equations 
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were 
1x , 

2x , 3x  - coordinates of the surface point (in Local Coordinate System),  vuF ,1
, 

 vuF ,2
,  vuF ,3  - functions of Surface Parameters  vu, . The Surface Parameters u  and v  

changes from 0 to 1.0. 

In the REGIONS X program surface parameters denoted as ]1[L  and ]2[L . So, three equations of 

variables ]1[L  and ]2[L  must be given to create a parametric surface. A user can write his own 

surface equations or get a predefined ones form Surface Library. 

When three valid surface functions are given – the preview of the surface is shown on the Main 

Screen. If there are errors in formulae – hints are displayed in the Log window. Use Create or 

Create+ button to create the surface. 

Creating Solids 

Use main menu command Geometry Model -> Create -> Solid Body to create a solid by existing 

surfaces. Solid Body window will be shown (picture 9). 

 
Picture 9. Solid Body window. 

 

Surfaces representing the boundary of the body must be selected to create a solid. Press Select 

button to select existing surfaces. The Object Selection window will be shown (picture 10). 

 
Picture 10. Object Selection window. 

With the Object Selection interface different selection methods can be used. Selection Type 

determines how objects will be selected. For an example, User Selection type will activate Object 

Browsing interface. By Name type allows object selection by their names and so on. Selection Mode 

determines how the selection is applied to the objects. For an example, From All mode means that 

selection is applied to objects directly. Add mode means that chosen objects are added to the 

already selected and so on. Surface selection by mouse can be activated by main menu command 

Geometry Model -> Select -> Select Surfaces by Pick.  

Selected objects are always displayed on the screen with Red color. When all required surfaces 

are selected – press Create or Create+ button to create the solid. 
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NOTE about solids: REGIONS Gamma-Gamma program modeling functions do not check the validness 

(connection of the surface edges, surface normal directions and so on) of the solids created. So, 

it is all user responsibility to check the solid validness. 

Use main menu command Geometry Model -> Create -> Parametric Solid to create a totally 

parameterized solid. Parametric Solid window will be shown (picture 11). 

 
Picture 11. Parametric Solid window. 

 

Parametric solid is a solid the boundary of which totally consists of parametric surfaces. All 

boundary parametric surfaces have the same parameters but different surface functions. So, to 

create a parametric solid three functions for each boundary surface must be given. A user can 

input his own surface equations or get predefined ones from the Solid Library. 

When valid surface functions are given – the preview of the solid is displayed on the main 

screen. If errors exist – the hints are shown in the Log window. Press Create or Create+ button 

to create the solid. 
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 Creating Boundary model 

 Boundary Model is a set of boundary objects those represent the boundary of the problem. 

Actually, boundary object is a collection of boundary elements. Boundary elements are mainly used  

to implement Particle Tracking for Monte-Carlo simulation algorithm. 

 Boundary model creation includes two procedures – creation of boundary objects (mesh the 

boundary) and setting boundary conditions. Before begin operation with Boundary Model it must be 

loaded into program memory. Use main menu command Problem -> Load Boundary Model to get it 

loaded.  

Creating Boundary objects 

 The simplest and fastest way to create boundary objects (mesh) is to create uniform mesh 

and then change the number of boundary elements for individual boundary objects. 

 Use main menu command Boundary Model -> Create -> Uniform Surface Mesh to create uniform 

mesh for a set of selected surfaces. Uniform Surface Mesh window will be shown (picture 12). 

 
Picture 12. Uniform Surface Mesh window. 

 

Press the Select Surfaces button to select surfaces with the Object selection interface. When 

surfaces selected, input the number of boundary elements, select the form of elements (quads or 

triangles) and the type of elements. Press Create or Create+ button to create the mesh. 

 If mesh operation completes successfully – created boundary objects will be displayed on 

the Main Screen (to switch between model views – use Main Screen popup menu command Plot -> …). 

 NOTE about uniform mesh: it is not always possible to produce really uniform mesh for any 

geometry object because of its natural “nonuniformness”, so the uniform mesh tool does not always 

produce the desired result. 

 Use main menu command Boundary Model -> Create -> Uniform Surface Mesh for Solid to create 

uniform mesh for all surfaces of selected solids. 

 Use main menu command Boundary Model -> Edit -> Increase/Decrease Boundary mesh  to change 

the number of boundary elements. Increase Boundary Mesh window will be shown (picture 13). 

 
Picture 13. Increase Boundary Mesh window. 
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Press Select Boundaries button to select boundaries with the Object Selection interface. 

Selection by mouse picking can be activated by main menu command Boundary Model -> Select -> 

Select by Pick. After boundary selection input (or choose) the ratio of mesh increasing and press 

Increase or Increase+ button to remesh objects. 

 NOTE about boundary objects: geometry model objects can be edited in any moment of Problem 

Solution procedure, even when the boundary objects created for some geometry objects. But 

boundary model is not updated automatically when the target geometry is changed. To update 

boundary objects use main menu command Boundary Model -> Remove/Refresh -> ….  

 

 Creating Measuring model 

Measuring Model is a set of Sources and Detectors. Sources are objects radiating the gamma 

quanta. Detectors are the objects fixing gamma quanta and registering their energy.  

 Use main menu command Measuring Model -> Sources -> Add Sources to create new source 

objects. Create Sources window will be shown (picture 14). 

 
Picture 14. Create Sources window. 

Press the Select Solids button to select solid geometry objects with the Object selection 

interface. When some solids selected, input the energy of radiating gamma quanta. Press Create or 

Create+ button to create the sources.  

 Use main menu command Measuring Model -> Detectors -> Add Detectors to create new detector 

objects. Create Detectors window will be shown (picture 15). 

 
Picture 15. Create Detectors window. 

Press the Select Solids button to select solid geometry objects with the Object selection 

interface. When some solids selected, press Create or Create+ button to create the detector 

objects. 

 When some measuring objects (sources or detectors) are created, they can be shown on the 

Main Screen Window (using the window’s Pop-Up menu Plot->Geometry/Measuring). An example of 

Measuring Model with one source and one detector is shown on picture 16. 
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Picture 16. An example of measuring model view. 

 

 

Setting Source and Detector properties 

 When creating Sources and Detectors, only main properties assigned to the created objects. 

To edit other properties use Main Menu commands Measuring Model->Sources->Edit Sources or 

Measuring Model->Detectors->Edit Detectors. The Main Object Inspector window will be shown 

(picture 17). 

 The Object Inspector allows editing all source and detector properties defining the gamma 

quantum distribution modeling process (for an example, source energy, source activity and so on). 

Also, the object’s view properties can be edited to display the measuring objects properly. 
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Picture 17. Main Object Inspector window. 

 

 

Solving Problem 

 Solving process can be executed by Solution->Solve main menu command. The solution 

progress can be viewed in the Log window. 

 Before solving the problem use main menu command Problem->Option (page Solution) to set 

appropriate solution option – total gamma quantum runs and so on. Solution options window is 

shown on the picture 18.  

 Main options are: 

- Total gamma count – the number of gamma quanta to be run during entire solution 

procedure. 

- Step gamma count – the number of gamma quanta to be run during one solution step. 

- Randomizing mode – if is on, the random number generator will start with different 

value. 

- Result for each step – if is on, the trajectories for each step will be saved in 

different result. 

- Postsolve each step – if is on, the trajectory statistic and spectrum data of all 

detector object will be shown for each step. 

- Result trajectories – the type of trajectories to save in the Result Model: 

No Trajectories – no trajectory saved in result; 

Detected Only – only trajectories caught by a detector saved in result; 

Interacted Only – only trajectories having an interaction saved in result; 

All Trajectories – all trajectories saved in result; 

Failed – only failed trajectories saved in result. 

- Analyse Duplicated Trajectories – if is on the solver will do analysis of duplicated 

trajectories and mark them with ‘Bad’ state.  

Other options are recommended to keep default values. 

 NOTE: It is not recommended to set ‘All Trajectories’ with Total gamma count higher than 

1000000 because it will take much memory and will lead to slow result plotting. 
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Picture 18. Problem solution options window. 

Results and postprocessing 

 After Solution procedure successfully completed, the calculated result added to the Result 

model. Spectrum data for all detector objects are also shown in the Log window and can be saved 

as text file. 

 Calculated gamma quantum trajectories can be viewed by executing command Result Model-> 

Plot Results. The Plot Results form will be shown (picture 19). Select the result for plotting 

and press Apply button – the result will be shown on the Main Screen. The result plot style and 

boundary plot style can also be selected to plot result in appropriate manner. 

 An example of gamma trajectories result is shown on picture 20. 

 



REGIONS Gamma-Gamma User Guide 

Copyright © Sergey L. Gladkiy 

17 

17 

 
 

Picture 19. Plot result window. 

 

 

 
 

Picture 20.Example of gamma trajectories result plot. 

 

 The result trajectories can be analyzed and managed using command Solution->Calculate 

Results->Analyse Trajectories. The Trajectory Analysis window is shown on the picture 21. Select 

results from the list and choose appropriate options. The following actions can be done: 

- Finding duplicated trajectories in results. 

- Changing trajectory state in results. 

- Delete trajectories with specified state. 

- Analyze nodes of trajectories (distances, directions).  

After analysis completion the summary is shown in the Log Window or report shown in new 

text window. 
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Picture 21. Trajectory Analysis window. 

  

 Let us consider an example of trajectory geometry analysis. First of all – select the 

results you need to analyze in the result list. Then, select the node state to be included in the 

analysis – let it is Interacted. Next select the local system for the analysis (all results will 

be calculated in the Local coordinates of the system), let it is Cylindrical system. And finally 

– select the analysis type, let it is Distance. Press the Analyse Geometry button and the report 

will be shown. The part of report is presented on picture 22, where Values – the gamma energy; 

States – the gamma state at the trajectory node; r, phi, z – cylindrical coordinates of the node 

position. 

 The additional analysis of the report can be done by external standard statistical tools. 

For an example, as we analyzed distances in Cylindrical coordinate system, we can create the 

histogram of distribution of node distance from the Z axis by analyzing local r coordinate 

(because here the r is actually the distance from Z axis). 
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Picture 22. A part of Geometry Analysis report. 

 

 

Solving Test Problems 
 There are several test problems, integrated in the REGIONS Gamma-Gamma program. They can 

be used as demonstrations of total solution procedure for simplest problems. Use main menu 

command Help -> Execute Tests to see existing test problems. Select a test in the shown Select 

Objects window and press Apply button to run test problem solution. Test Execution process can 

take several minutes. Test execution progress can be viewed in the Log window. After test 

execution successfully completed, the calculated result will be displayed. 

 

 

 


